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[bookmark: _ywo2911xax3r]3 Introduction
The ability to properly perceive audio is a precious gift. Properly functioning hearing allows us to communicate efficiently with others, experience rich and beautiful music, and sense important information about the world around us. However, our hearing is one of our most delicate senses, prone to significant and irreparable damage. Those who experience significant hearing loss lose the ability to perceive much of the beauty and character of the world around them. We would like to help these people by providing them with a product that tunes itself to their personal hearing and allows them to reclaim some of the auditory experience that they have lost.  Just imagine buying this gift for a grandparent who has become hard of hearing.  Imagine for them the experience of the sounds of their youth in a better way than they have ever heard the music.  It would bring back memories and the feeling of awe that you get when listening to a fantastic piece of music. 
The problem attempted to be solved is the annoying experience of rolling over your headphone wires with your desk chair.  The problem is getting tangled up as you try to do anything like cook or clean.  Reaching up and around your body pulling off your headphones mistakenly and interrupting your experience is a constant struggle.  The problem is the inherent decay of the human experience through physical trauma or age.  The problem is that your headphones always fall off as you try to go on a run, or they are just way too uncomfortable to use while exercising.This product seeks to turn back the clock on damage done, and stop the incessant distractions away from a perfect listening experience.
The idea of the bluetooth headphones was really to just do something that was really cool.  Build something that was difficult and involved some incredible technology and also produce a product that we would want.
In order to build the headphones we had to solve the problems.  The first problem to solve would be the implementation of noise cancellation.  This aspect would be taken care of by taking an incoming signal i.e. ambient noise from the environment and converting it into a digital signal by way of some transducers known as microphones.  This digital signal could then be inverted by use of an inverting amplifier, or internal processing in a dsp chip.  The next problem to be solved is the removal of wires.  The typical audio jack was to be replaced by a bluetooth signal built for audio functionality.  This would eliminate the wire problem that I mentioned earlier.  Audio data would be transmitted via high quality audio A2DP standard.  This is also known as “Advanced Audio Distribution Profile”.  The transfer of audio signals between any two devices can be made if they both support this standard.  
	Another aspect to be considered is the implementation of digital equalization.  The nature of the equalization curves are to be discovered through an audio examination delivered by an phone application that would go along with the headphones.  The examination would test the person's ability to hear at various frequencies across the auditory spectrum from 20 Hz all the way up to around 14-15kHz.  This is the range of the audible hearing spectrum.  It can go as high as 20 kHz but for all purposes 14-15 kHz will do the job.  These different data points would then be compiled into a set of equalization values that would be used by our digital signal processing chip to implement the curves on the music played.  The processing chip must be powerful enough to handle the need to equalize and boost sound signals as well as process the data coming from the microphones, invert the signal and boost it to appropriate levels to cancel out the ambient noise..
To solve these problems, we decided to focus on three primary hardware components, a central MCU to configure the other components and run the main software loop, a Bluetooth module that interfaces with a both a configuration app and audio sources, and a DSP processor that interfaces with the microphones and drivers and processes the negative feedback system that minimizes noise.
The Bluetooth module was the most difficult and software intensive, and was thus the component we focused on first. Even after the evaluation module and adapter were acquired, successfully connecting the module to an android phone was challenging.  
Our design thus far has not been able to meet expectations.  Each of the subsystems are moderately functional but we were unable to integrate each of them together to produce the result that we were looking for.  Instead our efforts in this report will be directed towards helping a future team tackle the problem of bluetooth noise canceling headphones in a much more efficient and streamlined manner.  We were able to implement the components involved in producing bluetooth headphones.  We were able to execute on signal inversion and nullify a sound.  We were able to create a link via bluetooth.  The integration of these subsystems together is where the difficulties came in.

4 Detailed System Requirements 
	In order to make the active noise cancellation work, the system needs to be able to record any incoming sounds and reproduce the filtered inverse of those sounds within 110 µs +/- 20µs.  This cancels out the incoming sound and allows the user to hear nothing but whatever they intend to listen to.
	Another requirement is that the headset be able to last for at least 2 hours at a reasonable volume.  More than 2 hours would be ideal, but as this is a prototype with a fairly cheap battery, 2 hours was the goal we set.
	In order to play music over Bluetooth, the system needs to utilize the Advanced Audio Distribution Profile (A2DP).  This is the standard for all high quality audio signal transfers over Bluetooth.  
The implementation of the Bluetooth A2DP must also lend itself to a low noise level.  Any audio signal transferred via Bluetooth must be as close in quality to the same audio signal transferred over wire as possible.  At the very least, there should be no audible difference.
	One of the requirements specific to our headset is that it needs to be able to equalize audio within different frequency bands.  The music must be able to be adjusted to match the user’s hearing profile in order to sound as close to the intended sound as possible.
	In order to measure the user’s hearing profile in the first place, the system must include a hearing test on the associated app.  This test must accurately measure any hearing loss the user has experienced and be able to save the user’s profile after the test has been completed.  This should allow the user to hear any music as it was intended to be heard.
	The physical system, the headset itself, needs to be comfortable enough to be able to be worn for multiple hours, preferably as long as the battery life lasts.  This will allow the user to get the most out of their experience.  This includes a headband of the right size and tension and padding around the ears.
	Finally, the system should be sized so that it contains all of the hardware necessary without being off balance or overly cumbersome.  This also pertains to the user’s comfort, but in a more general sense as it needs to be considered in all the aspects of the design.
[bookmark: _9b0tazfqcb43]

[bookmark: _k489ldp0xrdm]5 Project Description
[bookmark: _e1dpdds042c0]5.1 System theory of operation 
The baseline aspect of the system is the production of sound.  The production of sound begins at its recording.  A voltage is induced in a microphone which is simply described as a pressure sensor.  It receives the longitudinal waves and acts as a forced oscillator.  The frequencies of the physical oscillation are converted into voltage signals by way of Maxwell’s equations, namely Faraday’s law which governs the way in which voltages are produced by occurrences of varying magnetic flux in an arbitrary closed loop. 
	The voltages produced by the microphone are then sampled at more than twice the max frequency of the highest frequency sound wave that the microphone will interpret.  This means that the sampling frequency of the digitally recorded signal would be at least 30kHz or so to prevent aliasing.  The minimum requirement of sampling at double the frequency of the signal to be recorded is known as the Nyquist frequency.  Many problems arise in this stage of the music process.  Especially the fact that the device will have resonant fourier series components that could end up interfering constructively with other signals producing a recognizable amount of distortion.
	The recording hardware will not only be equipped with the appropriate sampling frequency, but it must also have a high enough resolution.  The resolution that I am referring to is the number of bits that will be used to describe the range of voltages produced by the microphone.  The simple example to understand this is that the number of different values to be stored by a bit resolution is equal to 2 raised to the power of the number of bits available per sample.  So if you have 8 bits available for sampling the number of values you can use to represent the range of input voltages would be 2^8.  This is 258 different available values to interpret voltage signal levels.
"A published estimate [Stevens, S.S., and Davis, H. Hearing, its psychology and physiology. New York: John Wiley, 1938] gives 330,000 as the approximate total number of monaurally distinguishable tones of all frequencies and intensities."  This value indicates that a 32 bit resolution would be the absolute maximum required resolution to discern all available sountds to the human ear.  At least with respect to monaurally distinguishable tones.  This would be 1000 times more available recording values compared to the human auditory perception.
	Now that a digital signal is recorded with a hypothetical 32 bit resolution 30 kHz minimum microphone and recorder, we need to compress the data.  In order to efficiently send the data by way of A2DP bluetooth communication profile we need to compress the audio data.  This is done by recognizing that the psychoacoustics of the human ear can not perceive as much of the data that is recorded by these high precision digital devices.  It is also done by reducing perceptual redundancy and the frequency components that are outside of the human auditory range of 20 - 15 kHz.  The very low and high frequencies can be the most easily removed as the optimal range of human hearing is from 200 Hz to a few kHz.
	The compressed audio data is then transmitted by bluetooth rf signal from a phone or audio player that is bluetooth compatible to our headphone’s bluetooth processor.  Bluetooth is a heavily involved software and hardware protocol that allows for the wireless communication of data.  I will provide an introductory explanation to its functionality for the purpose of this document.    For bluetooth devices to connect certain protocols are followed much like the examples of SPI and I2C that we know from senior design 1.
First, there is an agreement between the two bluetooth devices.  The agreement specifies how much data will be sent per sending period, when the data will be sent, and which devices are masters and slaves.  Also included in the agreements is frequency hopping protocols where the master and slave agree upon a certain sequence of frequency changes.  By having constantly changing frequencies in the communication protocol there is less likely a chance for interference and it increases the amount of data that can be sent over bluetooth.  A master bluetooth master device can connect to up to 7 slave devices each with a settable address.
1. How much data will be sent at a time?
2. How will devices speak to each other (protocol/profile)?  Bluetooth provides agreement on how this will be done.  Products have to agree on when bits are sent, how many will be sent at a time, and how message confirmation and checking will occur
Bluetooth has two layers.  The first layer called the lower layer makes up the hardware and radio transmission components of the devices. This describes physical characteristics of the radio.  This is the layer that performs modulation of the 2.4 GHz band.  Above the radio is the link manager protocol also known as the LMP.  This aspect of the bluetooth stack is responsible for data formatting, too and from the radio.  This part of the layer defines the characteristics of the communication.  From timing and framing to the size of packets and flow control.  This part of the protocol also receives instructions from the given HCI commands. 
	HCI is also known as the host controller interface.  This acts as an interface between the host controller and the hardware that is to be implemented.   The last major component of the stack to be described is the L2CAP (logical link control and adaptation protocol) which performs communication between upper and lower layers of the stack.  It is the data control center controlling where and when data is to be transfered.
	Each different type of communication to be sent will have an associated communication profile.  This profile describes how to implement bluetooth for a particular usage.  The one that we are interested in is the A2DP profile as mentioned above it is the Advanced Audio Distribution Profile.  For example the A2DP applies the interconnection of the layers listed above by taking advantage of the LMP and L2CAP protocols.  It uses these to control the radio interface and transmit the digital audio stream.  The link below provides the specification for A2DP communication:
https://www.bluetooth.org/docman/handlers/DownloadDoc.ashx?doc_id=260859&vId=290074
	Inversion of an input signal
Signal inversion can come in different forms.  Electrical engineering training points first in the direction of an inverting op - amp that will produce an output signal that is the inverse with a controllable amount of gain.  A visual depiction of the set up is bel[image: ]
The gain at V out is proportional to ratio of -Rf / Ri.  All you have to do is make this ration a little more than - 1.  This is determined by discerning the range of input voltages and current ratings of a microphone and optimising it so that the max voltage that we would see, would be close to the max voltage allowable by the audio processor.  The audio processor could then amplify even more as the inverted noise signal gets driven to the speaker drivers.
The voltage signal gets sent to the speaker drivers.  It is here that the electrical signal is turned back into a sound wave.  The voltage is applied to a coil that in turn applies a magnetic force to a diaphragm in the speaker.  This diaphragm will oscillate with all of the frequency components presented in speaker coils, in addition to the extra frequency components created due to non-linearities.  The mark of a good speaker driver is how well it is able to reproduce the original sound which means any non-original frequency components in the music would be minimized.  We will be sending both the audio signal and the inverted signal to the speaker drivers and the speaker drivers will have no problem playing all of the frequency components simultaneously as the movement induced in the diaphragm is a superposition of all of the voltage signal components presented in the output waveform.
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[bookmark: _psd84yjc59g7]5.3 Subsystem 1: Getting Bluetooth to Work

The A2DP is a complicated bluetooth profile.  Appropriately using all of the different layers of bluetooth is a task that requires a serious knowledge and appreciation of the bluetooth stack.  I would not recommend a ground up approach for getting bluetooth functionality in a project.  Rather the user should be able to implement a bluetooth set up as described by the break-out boards that are offered by Texas Instruments.  Texas instruments offers a good variety of example code and takes care of the hardware components of bluetooth implementation.  The boards that we used in order to get bluetooth operational were the “MSP432P401R” development board, the “EM Adapter BoosterPack” and for the actual bluetooth radio the “CC256xCQFN - Evaluation Module”.  Documentation for these devices are offered by TI are offered below:
http://www.ti.com/lit/ug/swru497a/swru497a.pdf?ts=1588850872975

For a complete evaluation solution, the CC2564CMSP432BTBLESW software development kit (SDK) works directly with the MSP-EXP432P401R LaunchPad™ The devices are shown below:
[image: ]
[image: ]
The devices get interfaced together using the EM adapter booster pack.  The devices use UART communication protocol to communicate from the MSP microcontroller to the CC256 bluetooth processor.  The three boards together:
[image: ]


We were able to successfully get a serial communication link working but this would not be sufficient for audio transmission.  A2DP would be required for our desired application.  
[bookmark: _2ididfdf06g7]5.4 Subsystem 2: Noise Cancelation
In order to get noise cancelling to work there are important factors to consider.  The first that we noticed during our experimentation was that you need an isolated system.  That is if you have your speaker simulating noise to a microphone and then having the microphone play back to the speaker you will have the obvious punishment of hearing “REEEEEEE” indicating an undesirable feedback loop.  This is why you need the isolated system.  The microphone receiving the input noise signal from the ambient speaker needs to be directed to a separate speaker that will not interact with the microphone whatsoever.  A pair of headphones is ideal and is our exact application.  The circuit set up that we had is as follows.
[image: ]
	Note that we tape the microphone with opposing polarity as we send it to by driving by our headphones through the audio jack.  The positive and negative rails are just that, the positive and negative terminals of a voltage source.  In order to generate a noticeable amount of noise we looked to the robust apx500 software found in the senior design room.  If a user is interested in getting a lot out of the software for recording data they should see that section of the user manual and potentially contact Professor Doug Hall.  An image of the software interface is below:

[bookmark: _gr23e0rfirl3][image: ]

The app allows users to produce noise that one might experience in different environments and is perfect for testing the efficacy of a pair of noise cancelling headphones.  The problems arise in that you need to have a noise signal that gets inverted, boosted and delivered to the headphones in 100us.  This aspect requires a very high speed processor to handle which is why it is necessary to have the dsp chip from the Boost 5545ULP with the dsp known as the C5545 ULP.
[bookmark: _jq1c2d63b17k]

[bookmark: _o9sshurhfr91]5.5 Phone Application
The phone application got as far as a user interface.  It was created by using react-native which takes a combination of react and html coding languages and makes them usable on both android and IOS devices.  The purpose of the phone application was to offer an interface that would allow a user to take the hearing exam.  The hearing exam itself was not successfully implemented.   Below are some screenshots from the UI operating on my phone:
[image: ]                                            [image: ]
The next step would be to create the actual hearing exam.  This would most efficiently be done by pursuing discovering how to make a sound.  This could be done on any programming language as the test could be implemented on the back end through an API call.  This is done by linking to a url that has the appropriate code completed to implement whatever it is you are trying to do.  In our case it is getting a hearing examination done.  A link to a description of how to do this is below:
https://enappd.com/blog/how-to-make-api-calls-in-react-native-apps/125/ 
[bookmark: _mujv56d340oh]5.6 Audio Processing
	The BOOST5545ULP evaluation module was selected for prototyping the audio processing component of the design because of its robust capabilities combined with very low power consumption and advertised plug-in compatibility with the MSP432 development board. It contains a C5545 ultra low power DSP processor and a built-in high performance AIC3206 audio codec which communicates with the main processor over I2C for configuration data and I2S for audio I/O.
[image: ]
This interface allows you to control the audio codec.  Any processing of audio data could be done through this codec which offers programmable inputs and outputs as well as the necessary hardware to implement equalization curves on output sound. An issue that we came across was while we were using the codec we found that the inputs from the mic and the outputs to the headphones included a significant amount of distortion.  This was most likely due to the number of bits allocated for sampling.  The spec sheet for the audio codec is listed below:
http://www.ti.com/lit/ds/symlink/tlv320aic3206.pdf?&ts=1588870340364 
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[bookmark: _u9hy0xnriy4m]6 System Integration Testing
[bookmark: _a2qkxnv0tqfo]6.1 Testing process for theoretical final prototype
1. Turn on the Audio Precision APx515
2. Open APx500 on the Audio Tech desktop. It will initialize the hardware and open with the following screen with the signal path 1 setup highlighted:
[image: ]
3. Connect the in-ear binaural microphones to an adapter that converts the 2.5mm plug into either two balanced XLR connectors or two unbalanced BNC connectors. Connect these into either the balanced or unbalanced analog input jacks on the front panel of the APx515 as appropriate:
[image: ]
[image: ]


4. Connect a loudspeaker into either the balanced or unbalanced analog output jacks on the APx515 using a similar adapter setup to the previous step:
[image: ]

5. In the signal path 1 configuration, select the appropriate analog input and output based on the adapters used in the previous steps:
[image: ]


6. In the Verify Connections panel, select Noise from the Waveform dropdown, and then select Pink from the Noise Shape dropdown. This will output a simulation of typical background noise to the attached loudspeaker:
[image: ]
7. Adjust the level as necessary to generate a realistic amount of noise in the room
8. Insert the binaural microphones into ears and place the headset over ears. Navigate to the Gain measurement on the left panel and note the measured gain on Ch1 in the data window.
9. Activate the noise cancelation and note the new Ch1 gain. The difference in gain is directly related to the effectiveness of the noise cancellation.
[bookmark: _bz0dpmwrlze6]

[bookmark: _j4wwk6nzhus]7 Users Manual/Installation manual  
[bookmark: _zclu5og2knkl]7.1 How to setup and run bluetooth SPP demo
1. Hardware Setup
a. Plug the CC256xCQFN-EM evaluation module into the RF headers on the BOOST-CCEMADAPTER board. 
b. Plug the BOOST-CCEMADAPTER board into the BoosterPack Headers on the MSP-EXP432P401R board. 
c. Final configuration:
[image: ]
2. Software setup
a. Install the latest version of Code Composer Studio from the Texas Instruments website: http://www.ti.com/tool/CCSTUDIO.
b. Download the dual-mode bluetooth stack: http://www.ti.com/tool/CC2564CMSP432BTBLESW.
c. Run the setup file and install the bluetooth stack.
d. Start Code Composer Studio and select Project → Import CCS Projects
e. Navigate to C:\TI\Connectivity\CC256XBT\CC256xMSP432BluetopiaSDK\4.2.x.x\Samples\SPPDemo\CCS and import the project
f. Open Project → Properties → General, and ensure that the “Manage the project’s target-configuration automatically” checkbox is set.
g. Connect the MSP432 development board with a micro USB cable.
h. Click on the Debug icon in Code Composer Studio and press the pause/run icon.







[bookmark: _4s57x54ebuxf]7.2 How to setup and compile code to run directly on the C5545
1. Install the following prerequisites from the TI website:
a. C55 code gen tool v4.4.1 (Version is important)
b. DSP/BIOS v5.42.1.09
c. C55x CSL Library: http://software-dl.ti.com/dsps/dsps_public_sw/dsps_swops_houston/C55X/latest/index_FDS.html
2. Open Code Composer Studio and navigate to Project → Import CCS Projects
3. Select the audio_demo project and import
4. Navigate to C:\ti\c55_lp and import the C55XXCSL_LP and atafs_bios_drv_lib
5. Navigate to C:\ti\c55_lp \ c55_csl_x.xx\inc\csl_general.h and change the macro definitions below:
#define CHIP_C5517 to //#define CHIP_C5517
#define CHIP_C5505_C5515 to //#define CHIP_C5505_C5515
#define CHIP_C5535 to //#define CHIP_C5535
6. Navigate to Properties → Build → C5500 Compiler → Processor Options in atafs_bios_drv_lib and change Specify memory model to huge.
7. Change Specify type size to hold results of pointer math to 32 if not specified In Properties → Build → C5500 Compiler → Advanced Options → Runtime Model Options.
8. Uncheck use large memory model, if checked.
9. Repeat the above three steps for the C55XXCSL_LP project.
10. Build C55XXCSL_LP and atafs_bios_drv_lib in both Debug and Release modes.
11. Right click on the project ‘C55AudioDemo’ and select ‘build Project’.
12. Navigate to c5545bp_audio_demo\bin and copy the compiled .bin file to the root directory of the microSD card. Insert the microSD card into the development board and power it on.
[bookmark: _habm84fgvftt]7.3 Setting-up React-Native for App Development
1. Install Node.js software on your device.  The link is below:
https://nodejs.org/en/download/
2. In your preferred command line interface, I happen to use windows powershell enter in the command 
npm install expo-cli --global
This will install the expo command line tool
3. Next you will make an expo account
a. simply follow the prompts to do so
4. In the folder that you want to save your code in run the command 
a. expo init myNewProject - this will create an expo project
b. cd myNewProject - navigates to the project
c. expo start - runs the required software to start developing your App!
It is recommended that you get a development environment such as atom.
If you download such an environment all you have to do is open up the "myNewProject" folder in atom and then you can modify the folder and develop your application.

5. Download the expo application to your phone
6. After you have used expo start you should see a QR code.  Take a picture of the QR code and it should open up expo on your phone with the application program running!

8 To-Market Design Changes
	The biggest to-market design changes would be to the physical headset.  Due to not being on campus, we were not able to develop a robust 3D printable design for our headset.  Not only did we have to adapt a design from someone else, but we were not able to see if all of our hardware would fit and work within the current design.  Additionally, the current design is intentionally rough as it is easy to set up and prototype with, in the event that we were able to assemble the full headset.
	The biggest change would be making the path for the wires to be fully within the headband, not just taped in place in a groove.  Additionally we would have to analyze the setup to make sure all of our electronics fit properly.  Finally, we would need to introduce padding around both the ears and the headband.
[bookmark: _nhczw79ltsie]9 Conclusions
We did not complete the noise cancelling headphones.  What we did do is dive into the process of learning how to make something happen.  We learned about audio signal processing.  We learned about data compression.  We learned how to connect devices over bluetooth.  We learned about the surprising difficulties when faced with building anything, especially the idea that things are hard and will take time and dedication to see it through.  I know I will hold onto the knowledge that I have gained in my senior design class as it will closely follow me into my personal life.  It will be there as I build projects involving microchips.  It will be there as we think in a project, what could go wrong?  It will be there in Ben’s career as he works as an FPGA developer and it will be there in Shannon’s life as she works on large products with Raytheon.  This class challenges you to do new things, and we certainly did that.  From working towards developing an app, to designing a case for a pair of headphones.  We worked on things we had never worked on before and that I feel is what this class was all about.  Pursuing something where you don't necessarily know the final destination. 
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[bookmark: _dxiqfne2pdej]10 Appendices
[bookmark: _pq4xtvik1wy8]Board Schematics
MSP432 processor and standard configuration
[image: ]
Debug buttons and LEDs
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Debug and boosterpack headers
[image: ]
Eagle board view with MSP processor and debug headers/pins
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CC256xCQFN-EM schematics from TI
[image: ]
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CC256xCQFN-EM PCB top layer layout
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BOOST5545ULP audio board block diagram
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BOOST5545ULP audio board schematics
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[bookmark: _8gyhbjluiamv]Code
Audio board main function and initialization
// RTS includes
#include <stdio.h>
#include <stdlib.h>
// DSP/BIOS includes
#include <std.h>
#include "c55AudioDemocfg.h"
// CSL includes
#include "csl_types.h"
#include "csl_error.h"
#include "soc.h"
#include "csl_intc.h"
#include "csl_rtc.h"
#include "csl_spi.h"
// application includes
#include "app_globals.h"
#include "pll_control.h"
#include "gpio_control.h"
#include "lcd_osd.h"
#include "codec_config.h"
#include "audio_data_collection.h"
#include "audio_data_read.h"
#include "user_interface.h"
#include "recognizer.h"
#include "sys_init.h"
#include "sys_state.h"

#define I2C_OWN_ADDR            (0x2F)
#define I2C_BUS_FREQ            (400)    // I2C 400Khz

extern Int SEG0;

extern pI2cHandle    i2cHandle;
CSL_SpiHandle	hSpi;

/*
 *  ======== main ========
 */
Void main(Void)
{
    Int16 p1, p2, p3, p4, p5; // for reading SAD parameters
    CSL_Status cslStatus;
    TIesrEngineStatusType tiesrStatus;
    TIesrEngineJACStatusType jacStatus;
    //MEM_Stat memStatBuf; // FL: debug
    //Bool status;

    /* Initialize DSP */
    cslStatus = DeviceInit();
    if (cslStatus != CSL_SOK)
    {
#ifdef DEBUG_LOG_PRINT
        LOG_printf(&trace, "ERROR: Unable to initialize DSP");
#endif
        exit(EXIT_FAILURE);
    }

    /* Reset Rx ping/pong buffer */
    resetRxPingPongBuf(gRxPingPongBuf, RX_PING_PONG_BUF_LEN, &gRxPingPongBufSel);

    /* Reset Rx circular buffer */
    resetRxCircBuf(gRxCircBuf, RX_CIRCBUF_LEN, &gRxCircBufInFrame, &gRxCircBufOutFrame, &gRxCircBufOvrCnt, &gRxCircBufUndCnt);

#ifdef ENABLE_TIESR
    /* Initialize the TIesr engine function object */
    TIesrEngineOpen(&tiesr);

    // FL: debug -- check used heap
    //status = MEM_stat(SEG0, &memStatBuf);

    /* Open an instance of the TIesr engine, loading the grammar */
    //tiesrInstance = (TIesr_t)malloc( memorySize * sizeof(short) );
    tiesrInstance = (TIesr_t)MEM_alloc(SEG0, TIESR_MEMORY_SIZE * sizeof(short), 0);
    if(tiesrInstance == MEM_ILLEGAL)
    {
#ifdef DEBUG_LOG_PRINT
        LOG_printf(&trace, "ERROR: Unable to allocate TIesr memory");
#endif
        exit(EXIT_FAILURE);
    }

    // FL: debug -- check used heap
    //status = MEM_stat(SEG0, &memStatBuf);

    tiesrStatus = tiesr.OpenASR(NULL, TIESR_MEMORY_SIZE, tiesrInstance); //Lali
    if(tiesrStatus != eTIesrEngineSuccess)
    {
#ifdef DEBUG_LOG_PRINT
        LOG_printf(&trace, "ERROR: Unable to open TIesr instance %d", tiesrStatus);
#endif
        exit(EXIT_FAILURE);
    }

    // FL: debug -- check used heap
    //status = MEM_stat(SEG0, &memStatBuf);

    /* Set parameters for recognition. There are many other parameters that
    could be adjusted. */
    tiesr.SetTIesrPrune(tiesrInstance, PRUNE_FACTOR);
    tiesr.SetTIesrTransiWeight(tiesrInstance, TRANSI_WEIGHT);
    tiesr.SetTIesrJacRate(tiesrInstance, JAC_RATE);

    tiesr.GetTIesrSAD(tiesrInstance, &p1, &p2, &p3, &p4, &p5);
    tiesr.SetTIesrSAD(tiesrInstance, p1, SAD_SPEECH_DB, p3, SAD_MIN_END_FRAMES, p5 );

    /* Open the JAC adaptation information. Since JAC file does not exist,
    then use an initial set of parameters */
    jacStatus = tiesr.JAC_load(NULL, tiesrInstance, NULL, NULL);
    if( jacStatus != eTIesrEngineJACSuccess )
    {
#ifdef DEBUG_LOG_PRINT
        LOG_printf(&trace, "Failed to load JAC %d", jacStatus);
#endif
        exit(EXIT_FAILURE);
    }
#endif /*  #ifdef ENABLE_TIESR */

    gEndRecog = TRUE;

    SWI_post(&SWI_SysInit);
}


SPP Main program

/*****< main.c >***************************************************************/
/*      Copyright 2012 - 2014 Stonestreet One.                                */
/*      All Rights Reserved.                                                  */
/*                                                                            */
/*  MAIN - Main application implementation.                                   */
/*                                                                            */
/*  Author:  Tim Cook                                                         */
/*                                                                            */
/*** MODIFICATION HISTORY *****************************************************/
/*                                                                            */
/*   mm/dd/yy  F. Lastname    Description of Modification                     */
/*   --------  -----------    ------------------------------------------------*/
/*   01/28/12  T. Cook        Initial creation.                               */
/******************************************************************************/
#include "Main.h"                /* Main application header.                  */
#include "HAL.h"                 /* Function for Hardware Abstraction.        */
#include "HALCFG.h"              /* HAL Configuration Constants.              */

#define MAX_COMMAND_LENGTH                         (64)  /* Denotes the max   */
                                                         /* buffer size used  */
                                                         /* for user commands */
                                                         /* input via the     */
                                                         /* User Interface.   */

#define LED_TOGGLE_RATE_SUCCESS                    (500) /* The LED Toggle    */
                                                         /* rate when the demo*/
                                                         /* successfully      */
                                                         /* starts up.        */

   /* Internal Variables to this Module (Remember that all variables    */
   /* declared static are initialized to 0 automatically by the         */
   /* compiler as part of standard C/C++).                              */
static unsigned int InputIndex;
static char         Input[MAX_COMMAND_LENGTH];

   /* Internal function prototypes.                                     */
static void ToggleLED(void *UserParameter);
static int GetInput(void);

   /* HCI Sleep Mode Callback.                                          */
static void BTPSAPI HCI_Sleep_Callback(Boolean_t SleepAllowed, unsigned long CallbackParameter);

   /* Application Tasks.                                                */
static void DisplayCallback(char Character);
static unsigned long GetTickCallback(void);
static void ProcessCharacters(void *UserParameter);
static void IdleFunction(void *UserParameter);
static void MainThread(void);

   /* The following function is responsible for retrieving the Commands */
   /* from the Serial Input routines and copying this Command into the  */
   /* specified Buffer.  This function blocks until a Command (defined  */
   /* to be a NULL terminated ASCII string).  The Serial Data Callback  */
   /* is responsible for building the Command and dispatching the Signal*/
   /* that this function waits for.                                     */
static int GetInput(void)
{
   char Char;
   int  Done;

   /* Initialize the Flag indicating a complete line has been parsed.   */
   Done = 0;

   /* Attempt to read data from the Console.                            */
   while((!Done) && (HAL_ConsoleRead(1, &Char)))
   {
      switch(Char)
      {
         case '\r':
         case '\n':
            /* This character is a new-line or a line-feed character    */
            /* NULL terminate the Input Buffer.                         */
            Input[InputIndex] = '\0';

            /* Set Done to the number of bytes that are to be returned. */
            /* ** NOTE ** In the current implementation any data after a*/
            /*            new-line or line-feed character will be lost. */
            /*            This is fine for how this function is used is */
            /*            no more data will be entered after a new-line */
            /*            or line-feed.                                 */
            Done       = (InputIndex-1);
            InputIndex = 0;
            break;
         case 0x08:
            /* Backspace has been pressed, so now decrement the number  */
            /* of bytes in the buffer (if there are bytes in the        */
            /* buffer).                                                 */
            if(InputIndex)
            {
               InputIndex--;

               while(!HAL_ConsoleWrite(1, "\b"))
                  ;
               while(!HAL_ConsoleWrite(1, " "))
                  ;
               while(!HAL_ConsoleWrite(1, "\b"))
                  ;
            }
            break;
         default:
            /* Accept any other printable characters.                   */
            if((Char >= ' ') && (Char <= '~'))
            {
               /* Add the Data Byte to the Input Buffer, and make sure  */
               /* that we do not overwrite the Input Buffer.            */
               Input[InputIndex++] = Char;
               while(!HAL_ConsoleWrite(1, &Char))
                  ;

               /* Check to see if we have reached the end of the buffer.*/
               if(InputIndex == (MAX_COMMAND_LENGTH-1))
               {
                  Input[InputIndex] = 0;
                  Done              = (InputIndex-1);
                  InputIndex        = 0;
               }
            }
            break;
      }
   }

   return(Done);
}

   /* The following is the HCI Sleep Callback.  This is registered with */
   /* the stack to note when the Host processor may enter into a sleep  */
   /* mode.                                                             */
static void BTPSAPI HCI_Sleep_Callback(Boolean_t SleepAllowed, unsigned long CallbackParameter)
{
//xxx Monitor low power state
}

   /* The following Toggles an LED at a passed in blink rate.           */
static void ToggleLED(void *UserParameter)
{
   HAL_LedToggle(0);
}

   /* The following function is registered with the application so that */
   /* it can display strings to the debug UART.                         */
static void DisplayCallback(char Character)
{
   while(!HAL_ConsoleWrite(1, &Character))
      ;
}

   /* The following function is registered with the application so that */
   /* it can get the current System Tick Count.                         */
static unsigned long GetTickCallback(void)
{
   return(HAL_GetTickCount());
}

   /* The following function processes terminal input.                  */
static void ProcessCharacters(void *UserParameter)
{
   /* Check to see if we have a command to process.                     */
   if(GetInput() > 0)
   {
      /* Attempt to process a character.                                */
      ProcessCommandLine(Input);
   }
}
   /* The following function is responsible for checking the idle state */
   /* and possibly entering LPM3 mode.                                  */
static void IdleFunction(void *UserParameter)
{
//xxx Fill in to put processor into low power mode
}

   /* The following function is the main user interface thread.  It     */
   /* opens the Bluetooth Stack and then drives the main user interface.*/
static void MainThread(void)
{
   int                           Result;
   BTPS_Initialization_t         BTPS_Initialization;
   HCI_DriverInformation_t       HCI_DriverInformation;
   HCI_HCILLConfiguration_t      HCILLConfig;
   HCI_Driver_Reconfigure_Data_t DriverReconfigureData;

   /* Configure the UART Parameters.                                    */
   HCI_DRIVER_SET_COMM_INFORMATION(&HCI_DriverInformation, 1, VENDOR_BAUD_RATE, cpHCILL_RTS_CTS);
   HCI_DriverInformation.DriverInformation.COMMDriverInformation.InitializationDelay = 100;

   /* Set up the application callbacks.                                 */
   BTPS_Initialization.GetTickCountCallback  = GetTickCallback;
   BTPS_Initialization.MessageOutputCallback = DisplayCallback;

   /* Initialize the application.                                       */
   if((Result = InitializeApplication(&HCI_DriverInformation, &BTPS_Initialization)) > 0)
   {
      /* Register a sleep mode callback if we are using HCILL Mode.     */
      if((HCI_DriverInformation.DriverInformation.COMMDriverInformation.Protocol == cpHCILL) || (HCI_DriverInformation.DriverInformation.COMMDriverInformation.Protocol == cpHCILL_RTS_CTS))
      {
         HCILLConfig.SleepCallbackFunction        = HCI_Sleep_Callback;
         HCILLConfig.SleepCallbackParameter       = 0;
         DriverReconfigureData.ReconfigureCommand = HCI_COMM_DRIVER_RECONFIGURE_DATA_COMMAND_CHANGE_HCILL_PARAMETERS;
         DriverReconfigureData.ReconfigureData    = (void *)&HCILLConfig;

         /* Register the sleep mode callback.  Note that if this        */
         /* function returns greater than 0 then sleep is currently     */
         /* enabled.                                                    */
         Result = HCI_Reconfigure_Driver((unsigned int)Result, FALSE, &DriverReconfigureData);
         if(Result > 0)
         {
            /* Flag that sleep mode is enabled.                         */
            Display(("Sleep is allowed.\r\n"));
         }
      }

      /* We need to execute Add a function to process the command line  */
      /* to the BTPS Scheduler.                                         */
      if(BTPS_AddFunctionToScheduler(ProcessCharacters, NULL, 200))
      {
         /* Add the idle function (which determines if LPM3 may be      */
         /* entered) to the scheduler.                                  */
         if(BTPS_AddFunctionToScheduler(IdleFunction, NULL, 0))
         {
            /* Loop forever and execute the scheduler.                  */
            while(1)
               BTPS_ExecuteScheduler();
         }
      }
   }
}

   /* The following is the Main application entry point.  This function */
   /* will configure the hardware and initialize the OS Abstraction     */
   /* layer, create the Main application thread and start the scheduler.*/
int main(void)
{
   /* Configure the hardware for its intended use.                      */
   HAL_ConfigureHardware(1);

   /* Enable interrupts and call the main application thread.           */
   MainThread();

   /* MainThread should run continously, if it exits an error occured.  */
   while(1)
   {
      ToggleLED(NULL);

      BTPS_Delay(100);
   }
}
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